Word Page Layouts and
Graphics

By Don Bremer
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Using the Ruler

Word’s rulers let you control the margins of your page and the indentation of paragraphs. They’re great
for precisely lining up images, text, and other elements. If you’re printing a document, the rulers can
help ensure that what you see on your screen translates into what you’ll get on the printed page.

The trouble is, rulers aren’t even visible by default in Word anymore. Here’s how to turn them on, and

how to make the most out of them. -
. I Arran
Turn on the ruler under View->Ruler I2 T ———— * r
The “Page Setup” window shows you most of the physical layout
properties of the document. The “Margins” tab lets you set the

margins for the top, bottom, left, and right, which you can verify with the markers on the ruler (see
below). The Gutter is extra space on the page, usually used as an extra blank space for things like comb
binding (those little plastic corkscrews that make a cheap notebook). It’s set as blank by default. You can
also use this tab to control page orientation.
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Changing Indents

Those little triangle- and box-shaped markers on the ruler are quite handy. They control the indenting of
individual paragraphs. Just position your cursor in the paragraph you want to adjust and slide them
around. If you want to change multiple paragraphs, select the paragraphs you want to change. And if
you want to change indents throughout the whole document, just hit Ctrl+A (to select everything), and

then adjust the sliders.

e,

8 pt

First Line Indent

Text

Hanging Indent

Left Indent

Here’s how each indent works.

Dragging the Left Indent marker changes the indentation for all lines of a paragraph. As
you slide it, the other two indent markers move as well. Here, I'm moving the Left Indent

half an inch in from the left margin.
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Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed
dolore magna aliqua. Ut enim ad minim veniam, quis nostru
aliquip ex ea commodo consequat. Duis aute irure dolor in 14
dolore eu fugiat nulla pariatur. Excepteur sint occaecat cupid
officia deserunt mollit anim id est laborum |

Dragging the First Line Indent marker changes indentation for only the first line of a paragraph.
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Lorem ipsum dolor sit amet, consectetur adipiscing e
labore et dolore magna aliqua. Ut enim ad minim veniam, qui
nisi ut aliquip ex ea commodo consequat. Duis aute irure dolg

cillum dolore eu fugiat nulla pariatur. Excepteur sint occaecat
officia deserunt mollit anim id est laborum.

Dragging the Hanging Indent marker changes the indentation of all lines except the first line.
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Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Maecenas porttitor congue mass
posuere, magna sed pulvinar ultricies, purus lectus malesuada libero, sit amet com)
eros quis urna. Nunc viverra imperdiet enim. Fusce est. Vivamus a tellus. Pellentes
morbi tristique senectus et netus et malesuada fames ac turpis egestas. Proin phar
nonummy pede. Mauris et orci. Aenean nec lorem.

In porttitor. Donec laoreet nonummy augue. Suspendisse dui purus, scelerisque at, vulputd
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On the right end of the ruler, you'll find only one marker: the Right Indent marker. Drag it to
constrain the paragraph on the right side.
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Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud
exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat. Duis aute irure dolor in
reprehenderit in voluptate velit esse cillum dolore eu fugiat nulla pariatur. Excepteur sint
occaecat cupidatat non proident, sunt in culpa qui officia deserunt mollit anim id est laborum.

Adding Tab Stops

A tab stop is the location your cursor moves to when you hit the Tab key. A default Word
document has no tab stops, so each time you hit the Tab key, the cursor jumps ahead about
eight characters. Setting tab stops lets you better control and line up text.

Of course, Word offers enough options that things get a little more complicated than that. If you

look all the way to the left edge of your document, just above the vertical ruler, you'll see the
Tab Stop button.
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Page Sety

Clicking this button lets you cycle through the different types of tab stops Word makes available.
Here they are:

Left: Left tabs are Word’s default tap stop. They’re what most people think of when they think of
tab stops, and what you'll likely use most of the time. Text is aligned against the left edge of the
tab stop.

Center: Center tabs align the text around the center of the tab stop.

Right: Right tabs align text against the tab stop’s right edge and are a great way to align the
rightmost digits of lengthy lists of numbers as you enter them.

Decimal: Decimal tabs align numbers (or text) based on decimal points. They are great for
aligning currency figures. Be careful, though. Text is also aligned on decimals, so if you type a
sentence with a period, the period will align on the tab stop.

Bar Tab: Bar tabs do not create an actual tab stop. Instead, they create a vertical line wherever
you insert them. You could use these for putting vertical lines between tabbed columns in
instances where you’d rather not use a table.

Indents: Select first line and hanging indent options and then click anywhere in the active ruler
space (the white area) to place the indent there. This works the same as dragging the indent
markers the way we discussed in the previous section.

A little tip for you. If you're cycling through tab stops and don’t remember what each symbol means,
move your mouse away from the button and then back to activate a tool tip describing that tab stop.
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This is pretty self-explainatory.
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Size

sizes of paper (or envelopes).

Line Numbers

If you work in the legal profession, this is awesome. This allows the computer to

number each line in the document and how it is to start over.
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Hyphenation

Although slightly before my time, when a word was too big to fit on a line
before the end of the page, a typist would break the word at a syllable and
put it on the next line. We are familiar with the computer automatically
starting the new word on another line if necessary, but Word can also
hyphenate the word if there isn’t enough room.

You already know that having a well-stocked spice rack or cabinet is essential to prepar-
ing a good meal, and you probably have rescued more than one dish by having just the
right spice on hand. But did you know that spices have been used for thousands of years
for everything from embalming Egyptian pharaohs to warding off evil spirits? Spices also
have been used to treat a host of illnesses, they have led to wars, and they have motivated
dozens of explorers to seek and discover new lands.

Figure 1 - With Hyphenation

You already know that having a well-stocked spice rack or cabinet is essential to
preparing a good meal, and you probably have rescued more than one dish by having just
the right spice on hand. But did you know that spices have been used for thousands of
years for everything from embalming Egyptian pharaohs to warding off evil spirits?
Spices also have been uised to treat a host of illnesses, they have led to wars, and they
have motivated dozens of explorers to seek and discover new lands.

Figure 2-Without Hyphenation

Working with columns
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Newsletters, brochures, and reports often present content in columns. Using columns can save space by

enabling you to present more information on a page.

To format text into columns:
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1. Select the text you want to format as columns.

2. Onthe Page Layout tab, in the Page Setup group, click Columns and choose More columns to
open the Columns dialog box

3. Under Presets, select a format. If you need more than three columns, enter the value in the
Number of columns box.

4. Adjust the width and spacing of the columns as needed.

Exercise — Formatting the text into columns.

Open Cookbook5

Place the insertion point in any of the recipes

On the Page Layout tab, in the Page Setup group, click Columns Select Two

Scroll through the document

Place the insertion point in the last section of the document. Display the Margins gallery and

select Normal

6. Click Columns and choose More Columns... Check Line Between Edit the Spacing box for column
1 to read 1 Press [Tab]

7. Click OK

8. Inthe Page Setup group, click Hyphenation and choose Automatic.

s W R

Inserting and deleting column breaks

A column break is a mark that indicates the end of a column. When one of the columns is longer than
another, you can insert a column break to balance them. The text after the break will move to the next
column. You might also want to start a paragraph at the beginning of a column or move a heading to the
next column to improve readability.

To insert a column break:

1. Place the insertion point where you want to insert the column break.
2. Click the Page Layout tab.
3. Inthe Page Setup group, click Breaks and choose Column.

Exercise — Inserting column breaks

1. On page 13, place the insertion point to the left of “Montego Bay Jerk Chicken”

2. Onthe Page Layout tab, in the Page Setup group, click Breaks and select Column

3. On page 13, insert a column break before “Big D Veggie Chili”

4. Insert column breaks before the Creme Bruelee and Wasabi Pork Tenderloin recipes.

Creating a heading that spans columns

Place the insertion point where you want the heading to appear, and type the heading text
Insert a Continuous section break after the text.

Place the insertion point in the section with the heading

Set the number of columns to one.

WP
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Exercise — Adding a heading across columns

1. On page 13, place the insertion point to the left of “Spicy Buzzard Wings” Type Cooking with
Outlander Spices

2. From the Breaks gallery, select Continuous

3. Press Backspace

4. Setthe number of columns to 1 Press [Enter] twice

5. Place the insertion point in the line Cooking with Outlander Spices Center the text horizontally
Graphics

For most of us, graphics in Word mean a picture. To insert a picture into a document, just drag and
drop!

Adjust a graphic
Grab a corner and drag toward the center. This will make it smaller. Going away
from the center will make it larger.

If you grab on the “swirly” at the top, you can put it to any angle you wish.

.

The last section is the rainbow. To tell the computer that text can be rapped around this picture, you
have to tell the picture it can have text wrapped around it.

]

3]

Layout Options

In Line with Text

A

With Text Wrapping

See more...

Then, how would you like the picture is moved as the text moves around the page?
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Vectored Graphics
This also known as Clip Art, or more appropriately Smart Art. Instead of putting in a clip of some
random person, we can now put in designs that help us make our point.

Have an idea Sell it to -
Retire!

¢ Should be a
unigue idea

Amazon

Symbols

If you’ve had to do academic papers, you know that there is more than English characters! For that
reason, we have the Symbol button. This will allow us to easily grab Greek characters or others that are
in use today.

Bonus Tip: This is a window that stays on top but does not keep you from editing your document. You
can have this up and add the symbol wherever the cursor is! e
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